VIRTUAL INSTITUTE - HIGH PRODUCTIVITY SUPERCOMPUTING

BSC Tools
Hands-On

Lau Mercadal Melia

(tools@bsc.es)
Barcelona Supercomputing Center




VIRTUAL INSTITUTE - HIGH PRODUCTIVITY SUPERCOMPUTING

Getting a trace with Extrae
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Extrae features

= Platforms -
= Intel, Cray, BlueGene, Intel MIC, ARM, Android, Fujitsu Sparc, IBM POWER..

= Parallel programming model
= MPI, OpenMP, pthreads, OmpSs, CUDA, OpenCL, Java, Python...

» Performance Counters

= Using PAPI interface
No need to

» Link to source code recompile
= Callstack at MPI routines or relink!
= OpenMP outlined routines
= Selected user functions

= Periodic samples

» User events (Extrae API)
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Extrae overheads
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Event

Event + PAPI

Event + callstack (1 level)

Event + callstack (6 levels)

BSCTOOLS HANDS-ON

150 - 200ns
750 - 1000ns

171ns 173ns
/55ns 1.4us

1us 5.3us
2.51s 121s
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How does Extrae work?

= Symbol substitution through LD_PRELOAD T
= Specific libraries for each combination of runtimes

MPI
OpenMP Recommended
OpenMP+MPI

CUDA

» Dynamic instrumentation

= Based on Dynlnst (developed by U.Wisconsin/U.Maryland)
= Instrumentation in memory
= Binary rewriting

* Function instrumentation through ™-finstrument-functions” compiler option

= Static link (i.e., PMPI, Extrae API)

BSCTOOLS HANDS-ON 5
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Using Extrae in 3 steps

1. Adapt your job submission script

2. Configure what to trace

= XML configuration file
= Example configurations in $EXTRAE_HOME/share/example

3. Run it!

» For further reference check the Extrae User Guide:
= https://tools.bsc.es/doc/html/extrae
= Also distributed with Extrae in $EXTRAE_HOME/share/doc

BSCTOOLS HANDS-ON 8
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Login to MareNostrum4

laptop> ssh -Y <USER>@mnl.bsc.es

loginl> 1s $HOME/tools-material
... apps/
clustering/
extrae_ cte-power/

extrae_mn4/
slides/ Here you have

src/ a copy of the slides

traces/
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Step 1: Adapt the job script to load Extrae with LD_PRELOAD

loginl> vi $HOME/tools-material/extrae_mn4/job.sh

#!/usr/bin/env bash

#SBATCH --job-name=lulesh_mn4_27p
#SBATCH --output=lulesh mn4 27p.out

#SBATCH --error=lulesh mn4 27p.err
#SBATCH --ntasks=27 B Request
#SBATCH --cpus-per-task=1 resources

#SBATCH --time=00:05:00
#SBATCH --reservation=PATCVIHPS

export OMP_NUM_THREADS=1

srun ../apps/lulesh mn4 -i 10 -s 65 -p Run the
program
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Step 1: Adapt the job script to load Extrae with LD_PRELOAD

loginl> vi $HOME/tools-material/extrae_mn4/job.sh

#!/usr/bin/env bash

#SBATCH --job-name=lulesh_mn4_27p
#SBATCH --output=lulesh mn4 27p.out
#SBATCH --error=lulesh mn4 27p.err
#SBATCH --ntasks=27

#SBATCH --cpus-per-task=1

#SBATCH --time=00:05:00

#SBATCH --reservation=PATCVIHPS

module load gcc/7.2.0 EXTRAE/3.6.1 Load Extrae module

export OMP_NUM_THREADS=1
export TRACE_NAME=lulesh_mn4_27p.prv

Name of the
resulting trace

srun ./trace.sh ../apps/lulesh mn4 -i 10 -s 65
<

Activate Extrae
during the run

BSCTOOLS HANDS-ON 11
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Step 1: Adapt the job script to load Extrae with LD_PRELOAD

loginl> vi $HOME/tools-material/extrae_mn4/trace.sh

BSCTOOLS HANDS-ON

module load gcc/7.2.0 EXTRAE/3.6.1

export OMP_NUM_THREADS=1
export TRACE_NAME=lulesh

~/apps/lulesh mn4 -i 10 -s 65

#!/usr/bin/env bash

#SBATCH --job-name=lulesh_mn4_27p
#SBATCH --output=lulesh mn4 27p.out
#SBATCH --error=lulesh mn4 27p.err
#SBATCH --ntasks=27

#SBATCH --cpus-per-task=1

#SBATCH --time=00:05:00

#SBATCH --reservation=PATCVIHPS

A 27p.prv

7

#!/usr/bin/env bash

# Configure Extrae

export EXTRAE_CONFIG_FILE=./extrae.xml

# Load the tracing library (choose C/Fortran)

export LD_PRELOAD=${EXTRAE

#export LD_PRELOAD=${EXTRAE_HOME}/lib/libmpAtracef.so

# Run the program
¢ *

Select
“what to trace”

_HOME}/1ib/libmpitrace.so

Select your

type of application

12
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Step 1: Which tracing library?

= Choose depending on the application type

m-m- OpenMP | pthread | CUDA _

libseqtrace

libmpitrace[f]! v

libomptrace v

libpttrace v

libcudatrace v
libompitrace[f] ! v v

libptmpitrace[f] 1 v v
libcudampitrace[f] 1 v v

1 include suffix “f” in Fortran codes

R —
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Step 3: Run it!

= Submit your job

loginl> cd $HOME/tools-material/extrae_mn4

loginl> sbatch job.sh

= Once finished the trace will be in the same folder: 1ulesh mn4 27p.{pcf,prv, row}
= Check the status of your job with:

loginl> squeue

= Any issue?
= Already generated at $HOME/tools-material/traces

BSCTOOLS HANDS-ON 14
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Step 2: Extrae XML configuration

loginl> vi $HOME/tools-material/extrae_mn4/extrae.xml

<mpi enabled="yes">
<counters enabled="yes" />
</mpi>

Trace the MPI calls
(What's the program doing?)

<openmp enabled="no">
<locks enabled="no" />
<counters enabled="yes" />
</openmp>

<pthread enabled="no">

<locks enabled="no" />
<counters enabled="yes" /> Trace the call-stack

</pthread> (Where in my code?)

<callers enabled="yes">
<mpi enabled="yes">1-3</mpi>
<sampling enabled="no">1-5</sampling>
</callers>

BSCTOOLS HANDS-ON



VIRTYUALAINSTITYUTE ~HIGHPRODUCTIVITY SUPERCOMPUTING

Step 2: Extrae XML configuration (II)

loginl> vi $HOME/tools-material/extrae_mn4/extrae.xml

<counters enabled="yes">
<cpu enabled="yes" starting-set-distribution="1">
<set enabled="yes" domain="all" changeat-time="500000us">
PAPI_TOT_INS,PAPI_TOT CYC,PAPI_L1_DCM,PAPI_L2_DCM,PAPI L3 TCM,PAPI_BR_INS,PAPI_BR_MSP,RESOURCE_STALLS
</set>
<set enabled="yes" domain="all" changeat-time="500000us">
PAPI_TOT_INS,PAPI_TOT_CYC,PAPI_SR_INS,PAPI_LD_INS

</set>
</cpu>
<network enabled="no" />
<resource-usage enabled="no" /> Select which HW counters
<memory-usage enabled="no" /> are measured
</counters>

(How's the machine doing?)

BSCTOOLS HANDS-ON
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Step 2: Extrae XML configuration (III)

loginl> vi $HOME/tools-material/extrae_mn4/extrae.xml

<buffer enabled="yes">

<size enabled="yes">5000000</size> Trace buffer size
<circular enabled="no" /> (Flush/ memory trade-off)
</buffer>

<sampling enabled="no" type="default" period="50m" variability="1em" />

Enable sampling

<merge enabled=“yes" (Want more details?)

v
()

synchronization="detenlt"
tree-fan-out="16"

nEqo Automatic
max-memory="512

post-processing
to generate the
Paraver trace

joint-states="yes"

keep-mpits="yes"

sort-addresses="yes"

overwrite="yes">

$TRACE_NAME$
</merge>

BSCTOOLS HANDS-ON
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Installing Paraver
&
First analysis steps

TECHNISCHE : :
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Install Paraver in your laptop

Downloads Publications

= Download from https://tools.bsc.es/downloads

Home » Downloads

Downloads

CORE TOOLS

Pick your version

EXTRAE PARAVER DIMEMAS
Instrumentation framewaork to generate execution Expressive powerful and flexible trace visualizer for High-abstracted network simulator for message
traces of the most used parallel runtimes. post-mortem trace analysis. passing programs.

Version 4.6.3 « 1.56 MB Version 5.2.12 « 1.09 MB
ORED L ELH 6 & 6

= Also available in MN under Ol wxparaver-4.8.1-win.zip

= $HOME/tools-packages
waparaver-4.8. 1-mac.zip

}\ wxparaver-4.8.1-Linux_i686.tar.gz (32-bits)
o wxparaver-4.8.1-Linux_x86_64.tar.gz (64-bits)

laptop> scp mnl:$HOME/tools-packages/ $HOME



https://tools.bsc.es/downloads

Install Paraver (1I)
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= Download tutorials:
= Documentation -> Tutorial guidelines

Download links

( Home Paraver » Dimemas » Extrae Research » Documentation » Downloads Publications.

news@tools:~ > Paraver 4.7.2 availll

Home » Documentation » Paraver tutorials

These seven tutorials can be opened with wxParaver versions newer than 4.3.0, and you'll be able to follow the steps within the tool. To install them, download
and untar the package and follow the instructions of the Help/Tutorial option on the Paraver main window. Following there is a list of available tutorials

ce with Paraver basic commands and the first steps of a

[2 Paraver introduction (MP

nfigure and run the Dimemas simulator and to start

Th
h Dimemas introductior ‘

= Also available in your $HOME
= $HOME/tools-packages

laptop> scp mnl:$HOME/tools-packages/

s of the MPI application Hydro and further
ith Dimi

t a representative region for a large trace that cannot be

Trace preparatior

o oo

o ards communications, use this
ace alignment tutorial

If you prefer you can downloa®

FOOTER (INSERT > HEADER AND FOOTER)
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Uncompress, rename & move

= Paraver

laptop> tar xf

laptop> mv wxparaver-4.8.1-1linux-x86_64 paraver

= Tutorials

laptop> tar xf

laptop> mv paraver-tutorials-20150526 paraver/tutorials

FOOTER (INSERT > HEADER AND FOOTER) 21



VIRTYUALAINSTITYUTE ~HIGHPRODUCTIVITY SUPERCOMPUTING

Check that everything works

= Start Paraver

laptop> $HOME/paraver/bin/wxparaver & Tutorials
Barcelona
. ] Supercomputing
» Check that tutorials are available Center = .
SALND Maciong! e SURerCompUTRcion
paraver |

File Hints | Help Index
‘ARl

Workspaces

INonE

Window browser
IAIITraces

Help Contents...
Tutorials...

1. Introduction to Analysis with Paraver - MPI

2. Introduction to the Use of Dimemas

3. Introduction to Paraver and Dimemas methodology

4 Analysis with Paraver & Dimemas - Methodology

Click on Help > Tutorials

5. HydroC Tutorial

b. Paraver trace preparation

= Remotely available in MareNostrum

laptop> ssh -Y @mnl.bsc.es
loginl> module load paraver

loginl> wxparaver &

BSCTOOLS HANDS-ON 22
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First steps of analysis

= Copy the trace to your laptop ( All 3 files: *.prv, *.pcf, *.row )

laptop> scp @mnl.bsc.es:$HOME/tools-material/extrae_mn4/lulesh* ./

Click on File > Load Trace

- File | Hints Hel
Load the trace p ‘ > Browse to the *.prv file

Previous Traces [ 2
Unload Traces
= Follow Tutorial #3
garestne
Supercompuiing
File Hintz | Help Center . B
. . . Help Contents.. Ceantra Naclonal de Supercomputacion

Workspaces Tutoria . Index

INDHE

Window browser

1. Introduction to Analysis with Paraver - MPT

IAII Traces

Click on Help - Tutorials

23
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Measure the parallel efficiency

= Click on "mpi_stats.cfg”

e B o | O %I|I|H|H||l|w E %

The computation regions

— e
THREAD 1.16.1 | 005%  003%  006%  038%  002%  000%
run?". The efficiency of a parallel pregram can be defined based on two aspects: the THREAD 1.18.1
regions. These two metrics would be the first checks on the proposed methodology. . :
» To measure the parallel efficiendlf load the configuration file
every thread spends in every MPI cjill. Look at the global statistics at the bottom of
e represents e aplicaionparale THREAD 1.22.1 | 005%  003%  007%  063%  003%  000%
efficiency, entry Avg/Max represents the global load balance and entry Maximum
represents e communicatonefcency I anyof hose velues ar ower han THREAD 1.23.1 | 007%  004%  004%  083%  002%  000%
Conwlwidow o eny . e vanont o e cose T | 005%  005%  005%  071%  003%  0.00%
control window to identify the phases and iterations of the code THREAD 1.24.1
ime disuibut THREAD 1.25.1 | 004%  003%  005%  079%  003%  000%
+ To measure the computation time distribution load the cenfiguratien file
histogram of the duration for the computation regions. The computation regions
histogram does not show vertical lines, itindicates the computation time may be
not balanced. Open the control window to look at the time distribution and visually
correlate both views.
Total 2,467.65 % 1.36 % 0.97 % 2.97 % 17.74 % 051% 2.99 %
* Tomeasure the compu °* o = | 91.39 % 0.05% 0.04 % 0.11% 0.66 % 0.02% 0.11%
ey Parallel efficienc = Maxim®
configuration pops up a V img | 98.04 % 0.09 % 0.08 % 0.36 % 1.22% 0.03% 0.94 %

to the next call. If the histogm 86.69 % 0.02 % 0.02 % 0.03 % 0.24 % 0.00 % 0.00 %
distribution of the instrud
look at the time distribut StDev 3.09 % 0.01% 0.01% 0.08 % 0.23% 0.01% 0.26 %

0.53 0.46 0.30 0.54 0.69 0.12

s  Comm efficiency
=l =l

[

Load balance
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Computation time and work distribution

= Click on “2dh_usefulduration.cfg” (2nd link) = Shows time computing

€ B @ I_
=

The first question to answer when analyzing a parallel code is "how efficient does it
run?”. The efficiency of a parallel program can be defined based on two aspects: the
parallelization efficiency and the efficiency obtained in the execution of the serial I / I
regions. These two metrics would be the first checks on the proposed methodology. I

s To measure the parallel efficiency load the configuration file /
cfgesnpisnpl stats cfgThis configuration pops up a table with %time that /
every thread spends in every MPI call. Look at the global statistics at the bottom of
the outside mpi column. Entry Average represents the application parallel /
efficiency. entry Avg/Max represents the global load balance and entry Maximum I
represents the communication efficiency. If any of those values are lower than
85% is recommended to look at the corresponding metric in detail. Open the
control window to identify the phases and iterations of the code

To measure the computation time distribution [{ed the configuration file
cfgsrgeneral ~2dh_ussfulduration of g This §onfiguration pops up a
histogram of the duration for the computation regiofls. The computation regions

- y to the next call. If the
histogram does not show vertical lines, it indicates the computation time may be
not balanced. Open the control window to look at the time distribution and visually

correlate both views /

e To measure the computational load (instructions) distribution load the I /
configuration file cfgs-papi 2dh useful instructions ofgThis
configuration pops up a histogram of the instructions for the computation regions.
The computation regions are delimited by the exit from an MPI call and the entry
to the next call. If the histogram doesn't show vertical lines, itindicates the
distribution of the instructions may be not balanced. Open the control window to I

Performance
look at the time distribution and correlate both views LI I , Y i m ba I a n ce
' (zig-zag)

a Tn measure the serial reninns narfarmance Innk at the TPC timeline Inaded

_;Ijj Close. 1
THREAD 1.2.1 [127,564.26..128,516.23) = 0 us

BSCTOOLS HANDS-ON 25
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Computation time and work distribution

= .. and “2dh_useful_instructions.cfg” (3rd link) = Shows amount of work

The first question to answer when analyzing a parallel code is "how efficient does it
run?”. The efficiency of a parallel program can be defined based on two aspects: the
parallelization efficiency and the efficiency obtained in the execution of the serial
regions. These two metrics would be the first checks on the proposed methodology.

s To measure the parallel efficiency load the configuration file
cfgesnpisnpl stats cfgThis configuration pops up a table with %time that
every thread spends in every MPI call. Look at the global statistics at the bottom of
the outside mpi column. Entry Average represents the application parallel
efficiency. entry Avg/Max represents the global load balance and entry Maximum
represents the communication efficiency. If any of those values are lower than
85% is recommended to look at the corresponding metric in detail. Open the
control window to identify the phases and iterations of the code

e To measure the computation time distribution load the configuration file
¥ Vi This configuration pops up a
histogram of the duration for the computation regions. The computation regions
are delimited by the exit from an MPI call and the entry to the next call. If the
histogram does not show vertical lines, it indicates the computation time may be
not balanced. Open the control window to look at the time distribution and visually
correlate both views

e To meaglire the computational load (instructions) distribution lofl the
configurgon file cfgsrpani 2dh _ussful instructions ofg Thi
configuraon pops up a histogram of the instructions for the computat@n regions.

to the next call. If the histogram doesn't show vertical lines, itindicates the
distribution of the instructions may be not balanced. Open the control window to
look at the time distribution and correlate both views

a Tn measure the serial reninns narfarmance Innk at the TPC timeline Inaded LI Wo rk

=l = o |

imbalance &% [719,061,017.51..723,315,810.21) = O us
(zig-zag)

BSCTOOLS HANDS-ON 26
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Where does this happen?

= Go from the table to the timeline

Click on
“Open Filtered
Control Window”

Select this area
(by drag-and-dropping)

FOOTER (INSERT > HEADER AND FOOTER)

useful instructions 20Zoom range [1.4891%9e+08,3.87187e+08) @ lulesh mnd 27p.prv.gz

. THREED 1.1.1

2dh useful instructions @ lulesh_mn4 :

THREAD 1.18.1

THREAD 1.19.1

THREAD 1.27.1
1

us

Right click = Fit
Semantic Scale 2
Fit both

THREAD 1.1.1 [719,061,017.51..723,315,810.21) = O us

27



Where does this happen?
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. m &m at the same time = Imbalance

2dh useful instructions @ lulesh_

€ B[R

THREAD 1.1.1

THREAD 1.13.1

nna :useful instructions 2DZoom range [1.43010g

Zoom into

1 of the iterations

(by drag-and-dropping)

THREAD 1.1.1

I THREAD 1.18.1

THREAD 1.1.1 [719,061,017.51..723,31]

THREAD 1.19.1

THREAD 1.27.1

1,417,855 us

FOOTER (INSERT > HEADER AND FOOTER)

263,161,982 - 263, 669, 425

08, 3.87187e+08) @ lulesh mnd 27p.prv.gz

useful instructions 2DZoom range [1.48910e+08, 3. 87187e+08) @ lulesh _mnd 27p.prv.gz

1,654, 4E7 us

28
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Where does this happen?

» Hints &> Callers - Caller function

useful instructions 20Zoom range [1.4891%e+08,3.87187e+08) @ lulesh _mnd 27p.prv.gz
THREAD 1.1.1

THREAD 1.148.1

THREAD 1.19.1 1 Right CIiCk 9

THREAD 1271 7 oms 263,161,982 - 263, 669,425 1.654,467 C
' I 2D us F.d » » £ o= L » r FL =1 4 ous opy

Right click 2>
MPI caller @ lulesh mnd_27p.prv.gz Paste » Time

THREAD 1.1.1

THREAD 1.5.1
THREAD 1.5.1
THREAD 1.13.1
THREAD 1.17.1

THREAD 1.21.1

FOOTER (INSERT > HEADER AND FOOTER) 29
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Save CFG’s (2 methods)

Copy CTRL+C

Paste 3
—

Clone

Right click on
timeline

useful instructions 2DZoom range [1.48919e+08,3.87187e+08) @ lulesh_mn4_27p.prv.gz
THREZD 1.1.1

THREAD 1.14@.1

Undo Zoom CTRL+L

THREAD 1.19.1

[
THREAD 1.27.1 Fit Time Scale
1,417,655 us 263,161,982 - 263,669, 425 us

Fit Semantic Scale 2
Fit Objects
Select Objects...

View

Paint As
Drawmode
Pixel Size
Object Labels
Object Axis

b . . . .

Run 2

Synchronize +

| _save | Configuration.

. Image...
Timing CTRL+T
Image Legend...
Info Panel

Text. ..

FOOTER (INSERT > HEADER AND FOOTER) 30



Save CFG’s (2 methods)
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useful instructions 2DZoom range [1.48919e+08,3.87187e+08) @ lulesh_mn4_27p.prv.gz
THREZD 1.1.1

THREAD 1.14@.1
THREAD 1.19.1

THREAD 1.27.1

1.417.8 263,161, 962 - 263,669, 425 1,654, 467 us

1. Main Paraver

window

File Hints Help
Load Trace

Previous Traces »
Unload Traces..

Load Configuration

Previous Configurations =

Load Session
Save Session CTRL+S

Preferences,
ith

Quit

T 20h useful nstructions
B useful instruction
&1 83 MPI caller

< | |

FOOTER (INSERT > HEADER AND FOOTER)

ave configuration

flulesh2.0_27p.prv

Timelines

=

Histograms

useful instructions @ Iulesh2.[]_;|
Instructions.cl @ lulesh2.0_27¢
 Useful.cl @ lulesh2.0_27p.prv

seful instructions i
structions.clcl @ lulesh2.0_
seful clcl @ lulesh2 .0 27p.pr
caller @ lulesh2.0_27p.prv
MPI caller @ lulesh2.0_27¢
call @ lulesh2.0_27p.prv 77

Unset all

Description

2. Select

MPI call profile @ lulesh2.0_27p.prv
2DH useful duration correlated witl
2dh useful instructions @ lulesh2.0

Set all Unset all I

[~ Save whole CFGin basic mode

~ Timeline options

¥ Relative begin time
¥ Relative end time

l Compute semantic scale

@ All trace
© All window

v Compute gradient limits

 Histogram options ————

Save Cancel |

-
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CFG’s distribution

= Paraver comes with many more included CFG's

File Hints Help

Load Trace...
Previous Traces »

Unload Traces...

Load Configuration...

Previous Configurations O Look in: IE' cfgs j ﬁl ﬂl [r:ll gl?

Save Configuration...

Load Session... CTRL+I - —= ' . .
Save Session . CTRL+S burst_mode |_DJ ava |_D sampling+folding
Preferences... _ cluste FiI'IEI h I'I'IFII h S5C riptE
ith N N N
Quit counters_PAPI |_D Omp5s |_D software_counters

| 2dh useful instructions
-- €3 useful instructions 2DZoom range [1.601542+0(
(- €3 MPI caller

] CUDA IS opencL IS spectral
I folding [ openMp
( | &l | General IS pthread

Files & Window Properties

-] lib -]
D libbsctools )

-] share File name: j DOpen
D src =

D Telegram J .
:g“mﬂiﬁf Files of type: Paraver configuration file (*.cfg) j Cancel
-

i @B hurct moada

el

Paraver files

FOOTER (INSERT > HEADER AND FOOTER) 32
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Hints: a good place to start!

= Paraver suggests CFG’s based on the information present in the trace

File | Hints Help

HE MPI profile

Work: callers p Point 2 point connectivity pattern

IF HWC » Histogram of durations per MPI call
flush W Histogram of message sizes per call

Windoworowser

| lulesh2.0_27p.prv |

-~ MPI call
- MPI call prafile
../ =8 Useful Duration
- % Instructions per cycle
-] 2DH useful duration correlated with
[#- &3 useful instructions
-] 2dh useful instructions
- &8 useful instructions 2DZoom range [1.60154e+0(
- &8 MPI caller

1| |

Files & Window Properties

= lib B
&[] libbsctools

&[] share

&[] sre

&[] Telegram J
&£ uncrustify

i m, B huret_mada

Ledle

Paraver files
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Use clustering analysis

= Run clustering

loginl> module load clustering suite/2.6.8

loginl> cd $HOME/tools-material/clustering

loginl> BurstClustering -d -i
-0

= If you didn’t get your own trace, use a prepared one from:

loginl> 1s $HOME/tools-material/traces/lulesh_mn4_27p.prv

= Copy the results to your computer

laptop> scp @mn1l:$HOME/tools-material/clustering/* .
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Cluster-based analysis

= Check the resulting scatter plot

laptop> gnuplot

- Identify main computing trends
9e+08 = T T T T T T Noise
= Work (Y) vs. Speed (X) | G ©
g 6008 | 1 Cusers
2 Custer 10
= | ook at the clusters shape 8= L | cuserts
= Variability in both axes indicate R g
potential imbalances BRI o < :>
It e}
2e+08 | 45 f_U -
1e+08 |- :6
>
0.8 "1:2
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Correlating scatter plot and time distribution

= Open the clustered trace with Paraver and look at it

laptop> $HOME/paraver/bin/wxparaver

= Display the distribution of clusters over time
» File > Load configuration > $HOME/paraver/cfgs/clustering/clusterID_window.cfg

ID @ lulesh 427 lust d.
griZ @ ‘u'esn mnf 2/p S ustarec-pry Cluster Analysis Results of frace 'lulesh_mn4_27p.prv'
DBSCAN (Eps=0.025, MinPoints=4)

Noise

T T T T T T T T T
Variable work /
L ] Cluster2
d Clusterd 0O
Cluster4 W
Spee L s C|3§|2:5 ©
Clusteré @
Cluster 7
+ i . cﬁzlg:a

Cluster 9
| Cluster10
Cluster 11

Simultaneously @
different processes

Imbalances
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